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ĐỀ XUẤT MỘT SỐ BIỆN PHÁP NÂNG CAO CHẤT LƯỢNG  
GIỜ ÔN TẬP, LUYỆN TẬP PHẦN HÓA HỌC HỮU CƠ LỚP 11 

 
TRIỆU THỊ KIM LOAN* 

 

TÓM TẮT 
Nhằm nâng cao chất lượng giờ ôn, luyện tập phần hóa hữu cơ lớp 11, một số biện 

pháp được đề xuất là: Sử dụng hệ thống câu hỏi định hướng và bài tập bổ trợ để hướng 
dẫn học sinh chuẩn bị bài; Sử dụng hệ thống bài tập đúng mục tiêu, đúng chủ đề; Hướng 
dẫn học sinh sử dụng phần mềm Mind Mapper để ôn tập; Sử dụng phương pháp dạy học 
nêu vấn đề, phương pháp grap, phương pháp algorit; Tổ chức thảo luận nhóm; Phân bố 
thời gian hợp lí; Phối hợp hài hòa các phương pháp dạy học trong giờ ôn, luyện tập.  

ABSTRACT  
Proposing some measures to improve the quality of review and practice periods for 

organic chemistry grade 11 
Aiming at improving the quality of review and practice periods of organic chemistry 

grate 11, a number of measures are proposed: using the system of oriented questions and 
exercises to guide students to prepare the lessons, the system of exercises with appropriate  
objectives and themes; problem-based and graph  teaching methods; algorism teaching 
methods; teaching students how to use the Mind Map software in reviewing; organizing 
group discussion; showing students how to distribute the reasonable time during the 
review and practice periods; coordinating teaching methods in the review and practice 
time in a harmony way.  

 

1. Mở đầu 
Theo Tony Buzan: “ Trong vòng 24 

giờ, ít nhất 80% thông tin chi tiết của một 
giờ học sẽ bị quên”. Điều đó cho thấy ở 
bất kỳ môn học nào việc ôn tập, luyện tập 
cũng là một khâu vô cùng quan trọng.  

Phần hóa học hữu cơ trong chương 
trình Trung học phổ thông (THPT) hiện 
nay là một phần có nhiều điểm mới và 
khó về nội dung cũng như phương pháp. 
Đặc biệt, phần hóa học hữu cơ lớp 11 có 
liên quan nhiều đến phần hóa học hữu cơ 
lớp 12 và thường là nội dung quan trọng 
trong các đề thi Đại học & Cao đẳng 
hằng năm. Để đạt được giờ dạy bài ôn,  
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luyện tập phần hóa hữu cơ lớp 11 hay và 
có chất lượng, đa số giáo viên còn lúng 
túng. Vì dung lượng kiến thức thì quá 
lớn, những kĩ năng đòi hỏi phải rèn luyện 
cho học sinh thì nhiều mà thời gian lại có 
giới hạn. Qua thực tế giảng dạy, tác giả 
xin trình bày một số biện pháp nâng cao 
chất lượng giờ ôn, luyện tập phần hóa 
hữu cơ lớp 11, góp phần nâng cao hiệu 
quả dạy học bộ môn hóa học ở trường 
THPT.  
2. Một số biện pháp nâng cao chất 
lượng giờ ôn tập, luyện tập phần hóa 
hữu cơ lớp 11 
2.1. Biện pháp 1: Sử dụng hệ thống 
câu hỏi định hướng và bài tập bổ trợ để 
hướng dẫn học sinh chuẩn bị bài trước 
giờ ôn, luyện tập trên lớp 
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Vào giờ ôn, luyện tập trên lớp, nếu 
không có một định hướng cụ thể về nội 
dung của bài học thì chắc chắn học sinh 
sẽ thụ động, tiếp thu chậm và giờ học ấy 
sẽ kém chất lượng. Để giúp học sinh định 
hướng mục tiêu bài học, hoạt động tích 
cực, tiếp thu bài nhanh, giáo viên cần xây 
dựng một hệ thống câu hỏi định hướng 
bài ôn tập và một số bài tập bổ trợ phát 
trước, yêu cầu học sinh chuẩn bị ở nhà. 
Việc này có tác dụng giúp học sinh hình 
dung được giờ học sắp đến sẽ ôn lại 
những nội dung trọng tâm nào, rèn luyện 
những kĩ năng gì. Hệ thống câu hỏi định 
hướng và bài tập bổ trợ là tài liệu cần 
thiết giúp học sinh tự học. Nó không chỉ 
mang tính chất tái hiện kiến thức đơn 
thuần mà còn nhằm gợi mở, phát triển kĩ 
năng tư duy. Để đáp ứng với nhiều đối 
tượng học sinh trong một lớp, nó phải 
tương ứng các mức độ: nhận biết, hiểu, 
vận dụng, phân tích, tổng hợp, đánh giá 
theo các tiêu chí của Bloom. Qua đó, học 
sinh sẽ thấy được một loạt các tình huống 
liên quan đến bài học cần giải quyết.  

Khi vào giờ ôn, luyện tập chính 
thức, học sinh đã có tâm lí chủ động, sẵn 
sàng tham gia các hoạt động với nhau và 
với giáo viên. Các em sẽ tích cực hơn 
trong việc chiếm lĩnh tri thức.  
2.2. Biện pháp 2: Sử dụng hệ thống 
bài tập trong giờ ôn, luyện tập đúng 
mục tiêu, đúng chủ đề 

Mục tiêu ở đây được hiểu là các 
mức độ cần đạt được của học sinh về 
kiến thức, kĩ năng trong giờ ôn, luyện 
tập. Chủ đề là vấn đề chủ yếu của bài ôn, 
luyện tập mà học sinh cần nắm bắt trong 

giờ học. Trong giờ ôn, luyện tập, việc 
chọn lựa các bài tập sao cho đúng mục 
tiêu, đúng chủ đề có tầm quan trọng rất 
lớn.  

Ví dụ: Đối với hóa học hữu cơ lớp 
11, dựa vào nội dung chương trình có thể 
phân ra các chủ đề: 

- Bài tập về cấu trúc phân tử hợp chất 
hữu cơ; 

- Bài tập về hiđrocacbon; 
- Bài tập về dẫn xuất của 

hiđrocacbon: Dẫn xuất halogen; ancol; 
anđehit; axit cacboxylic.    

Đối với mỗi bài luyện tập, có thể 
phân ra các chủ đề tương ứng với các 
dạng bài tập.  

Ví dụ ở bài 44 - luyện tập 
Hidrocacbon không no (sách giáo khoa 
hóa học 11 nâng cao, 2007), mục tiêu về 
kiến thức là: 

- Học sinh biết sự giống và khác 
nhau về tính chất giữa anken, ankin, 
ankađien; nguyên tắc chung điều chế các 
hiđrocacbon không no dùng trong công 
nghiệp hóa chất. 

- Học sinh hiểu mối liên quan giữa 
cấu tạo và tính chất của các loại 
hiđrocacbon. 

Mục tiêu về kĩ năng là viết phương 
trình hóa học minh họa tính chất của 
anken, ankađien, ankin. So sánh ba loại 
hiđrocacbon này với nhau và với 
hiđrocacbon no.  

Tương ứng với các mục tiêu trên, ta 
có thể chia thành các chủ đề: 

- Khái niệm độ không no của phân tử 
hợp chất hữu cơ (Л+v); 



Tạp chí KHOA HỌC ĐHSP TP HCM   Triệu Thị Kim Loan 
_____________________________________________________________________________________________________________ 
 
 

 83

- Phân biệt ankan, anken, ankađien, 
ank-1-in; 

- Hoàn thành sơ đồ chuyển hóa giữa 
các chất; 

- Tính thành phần hiđrocacbon trong 
hỗn hợp. 
2.3. Biện pháp 3: Hướng dẫn học sinh 
sử dụng phần mềm Mind Mapper để ôn tập 

Phương pháp bản đồ tư duy hay 
giản đồ ý (Mindmap) là phương pháp 
được đưa ra để tận dụng khả năng ghi 
nhận hình ảnh, màu sắc của bộ não. Đây 
là cách để ghi nhớ chi tiết, tổng hợp, hay 
phân tích một vấn đề thành một dạng của 
lược đồ phân nhánh.  

Phần mềm Mind Mapper là công cụ 
hỗ trợ cho người học ôn tập theo phương 
pháp lược đồ tư duy. Nó giúp cho người 
học tổ chức thông tin và tăng cường tư 
duy. Trong dạy học, đây là cách phát 
triển tư duy logic hiệu quả, giúp học sinh 
dễ hiểu bài và nhớ lâu. Những hình ảnh 
được tạo ra từ phần mềm Mind Mapper 
sẽ làm cho học sinh hứng thú.  

Để hướng dẫn học sinh sử dụng 
phần mềm này, giáo viên cần đưa ra sơ 
đồ tóm tắt nội dung bài học ở phần củng 
cố của bài luyện tập. Qua đó, giáo viên 
hướng dẫn học sinh sử dụng phần mềm 
theo các bước được trình bày dưới đây. 
Hoặc giáo viên có thể nêu ra chủ đề rồi 
hướng dẫn học sinh tự lập sơ đồ tư duy 
bằng phần mềm theo ý thích. Sau đó, 
giáo viên yêu cầu học sinh nộp các sơ đồ 
tư duy đã thiết lập và tổ chức cho cả lớp 
nhận xét, đánh giá, bổ sung kiến thức cần 
thiết.  

Cách tạo sơ đồ ôn tập bằng phần 
mềm Mind Mapper 

Bước đầu của quy trình lập sơ đồ 
ôn tập trên nền phần mềm Mind Mapper 
là thực hiện như phương pháp grap. Giáo 
viên phải hướng dẫn học sinh tìm ra được 
kiến thức chốt của một bài, một chương 
hay một vấn đề cần ôn tập bằng hệ thống 
câu hỏi định hướng. Khi vẽ sơ đồ, bắt 
đầu với đề mục trung tâm; xác định đề 
mục phụ để triển khai các nội dung của 
đề mục trung tâm.  

Để sử dụng phần mềm Mind 
Mapper ta cần nắm được các thao tác sau: 

- Chuẩn bị:  
+ Vào Website 

http://www.mindjet.com/ để dowload 
bảng freetrial; 

+ Chạy File.exe dowload để được 
cài đặt; 

+ Chạy Unikey chọn kiểu mã 
Unicode để viết tiếng Việt trong sơ đồ. 

- Sử dụng cơ bản: 
+ Khi giao diện của phần mềm hiện 

ra, vào New Map trong File để chọn các 
hình dạng của sơ đồ thích hợp; 

+ Gõ vào Title tên đề mục trung 
tâm cần ôn tập; 

+ Gõ vào các ô Topic những ý 
tưởng chính trong chủ đề; 

+ Nếu muốn thêm một Topic cùng 
cấp: click chuột vào Title, sau đó vào 
Insert → Topic → Single Sub-Topic để 
gõ ý tưởng; 

+ Khi cần thêm một Topic con (Sub 
Topic) cũng click vào ô Topic và tạo Sub 
Topic bằng cách tương tự như trên. 
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+ Có thể chỉnh sửa, sắp xếp lại vị trí 
các đề mục kể cả khi đã vẽ xong sơ đồ. 
Để di chuyển một Sub Topic từ Topic 
này sang Topic khác, ta click chuột vào 
Sub Topic, giữ chuột và rê sang nơi mới. 
Dùng cut, copy, past trên thanh công cụ 
để di chuyển đề mục; 

+ Lưu sơ đồ đã thiết lập: Nhấn Ctrl-
S hoặc click menu File → Save; 

+ Muốn mở một sơ đồ cũ đã lưu: 
click vào biểu tượng phần mềm đã được 
cài đặt khi giao diện hiện ra chỉ cần click 
vào File → Open.  
2.4. Biện pháp 4: Sử dụng phương 
pháp dạy học nêu vấn đề  

Khi hướng dẫn học sinh ôn, luyện 
tập, giáo viên cần tạo ra các tình huống 
có vấn đề để học sinh phải suy nghĩ, tự 
tìm ra cách giải quyết. Kinh nghiệm cho 
thấy, những tình huống có vấn đề thường 
đưa học sinh vào tâm thế chủ động học 
tập. Học sinh cũng sẽ hứng thú trước 
những tình huống bất ngờ.  

Điều khó khăn khi sử dụng phương 
pháp này là những tình huống có vấn đề 
còn mới lạ hay quá khó thường làm cho 
học sinh lúng túng. Học sinh buộc phải 
suy nghĩ lâu, mất nhiều thời gian dẫn đến 
tình trạng cháy giáo án, hoặc những 
khoảng lặng trong giờ học. Vấn đề đặt ra 
nếu vượt quá khả năng thì học sinh sẽ 
chán nản, dẫn đến tâm lí thụ động, chờ 
đợi giáo viên giải quyết. Vì thế, yêu cầu 
đối với vấn đề đặt ra là phải vừa sức, phù 
hợp với trình độ của học sinh.  

Với thời lượng tiết học là 45 phút, 
giáo viên nên sử dụng tình huống có vấn 
đề ở mức độ vừa phải, đủ để học sinh 

thực hiện theo ba bước: Đặt vấn đề, giải 
quyết vấn đề và kết luận vấn đề. Dạy học 
nêu vấn đề ơrixtic được tiến hành ở ba 
mức độ khác nhau tùy theo trình độ của 
học sinh. Ở mức độ thứ nhất, chỉ có giáo 
viên thực hiện, gọi là thuyết trình ơrixtic. 
Ở mức độ thứ hai, cả giáo viên và học 
sinh cùng thực hiện, gọi là đàm thoại 
ơrixtic. Ở mức độ thứ ba đòi hỏi học sinh 
tự thực hiện, gọi là nghiên cứu ơrixtic.  
Với trình độ chung của đa số học sinh 
THPT hiện nay, ta nên dùng mức độ thứ 
hai. Giáo viên phải luôn theo dõi, dẫn 
dắt, gợi ý để học sinh nhận ra vấn đề, xác 
định vấn đề, giải quyết vấn đề một cách 
nhanh chóng.  

Ví dụ: Khi ôn tập về hiđrocacbon ở 
bài 49 - luyện tập So sánh đặc điểm cấu 
trúc và tính chất của hidrocacbon thơm 
với hidrocacbon no và không no (sách 
giáo khoa hóa học 11 nâng cao, 2007), 
giáo viên có thể đặt vấn đề: Cho những 
chất sau: dung dịch Br2, H2 (Ni, to), HCl, 
H2O (H+). Chất nào cộng được vào aren, 
anken, ankin? Nếu học sinh nắm vững 
đặc điểm cấu tạo của từng loại 
hiđrocacbon thì việc chọn được các chất 
phản ứng đúng yêu cầu không khó. Từ 
đó, học sinh dễ dàng kết luận: chất cộng 
được với aren là: H2 (Ni, to), chất cộng 
vào anken và ankin là: Br2 (dung dịch), 
H2 (Ni, to), HCl, H2O (H+). 
2.5. Biện pháp 5: Sử dụng phương 
pháp grap dạy học  

Phương pháp grap được hiểu là 
phương pháp dạy học bằng sơ đồ phản 
ánh trực quan, tập hợp những kiến thức 
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chốt của một nội dung dạy học và cả 
logic phát triển bên trong của nó.  

Mục tiêu của các tiết ôn, luyện tập 
là tái hiện kiến thức một cách có hệ 
thống. Nó giúp học sinh thấy rõ mối quan 
hệ chặt chẽ giữa các kiến thức với nhau 
theo logic xác định. Từ đó, học sinh dễ 
ghi nhớ, vận dụng và giải quyết các vấn 
đề học tập. Vì vậy, việc sử dụng phương 
pháp grap tạo ra mối liên hệ giữa các 
phần kiến thức là rất cần thiết. Nhờ grap, 
học sinh có được cái nhìn tổng thể về 
kiến thức trọng tâm, nội dung chi tiết 
cùng các mối quan hệ bản chất giữa các 
kiến thức.  

Để sử dụng phương pháp này, giáo 
viên có thể: 

- Hình thành grap nội dung bằng hệ 
thống câu hỏi. Học sinh lần lượt trả lời 
các câu hỏi, đồng thời sắp xếp các kiến 
thức trọng tâm của chương, phần và nội 
dung chi tiết của chúng vào grap. Bằng 
sự so sánh, phân tích, tổng hợp, học sinh 
tìm ra mối quan hệ bản chất của các kiến 
thức đó.  

- Lập sẵn grap nội dung. Sau đó, yêu 
cầu học sinh khai thác mối liên hệ giữa 
các kiến thức, tìm hiểu nội dung chi tiết 
trong grap. Việc này có tác dụng tiết 
kiệm được thời gian ôn tập ở lớp, dành 
thời gian cho học sinh rèn luyện những kĩ 
năng cần thiết khác. 

- Hướng dẫn cách lập grap nội dung. 
Yêu cầu học sinh tự lập grap nội dung ở 
nhà trước giờ ôn, luyện tập. Đến lớp, học 
sinh trình bày grap đã lập; giáo viên điều 
chỉnh, bổ sung thành grap chuẩn để học 
sinh có tài liệu học tập. 

- Cung cấp cho học sinh grap câm 
gồm các khung kiến thức chốt và các nội 
dung bên trong chưa được triển khai đầy 
đủ. Dựa vào hệ thống câu hỏi, giáo viên 
gợi ý giúp học sinh thành lập một grap 
nội dung hoàn chỉnh. Grap câm là một 
dạng grap định hướng giúp học sinh hoàn 
thành grap mà không phải dùng nhiều 
ngôn ngữ dẫn dắt. Học sinh có thể làm 
việc độc lập, phát huy khả năng tự học 
của mình.  

Kinh nghiệm cho thấy, nếu grap 
thành lập với các thông tin được mã hóa 
càng đơn giản, học sinh càng dễ tiếp thu 
và vận dụng tốt. Với những grap phức 
tạp, quá nhiều kiến thức chi tiết, học sinh 
dễ bị rối. Vì vậy, khi sử dụng phương 
pháp này, giáo viên cần chọn lựa phần 
kiến thức trọng tâm để đưa vào grap. 
Những kiến thức không trọng tâm chỉ nên 
đề cập thêm khi xét thấy cần thiết.  

Ví dụ: Ở bài 37 - luyện tập Ankan 
và xicloankan (sách giáo khoa hóa học 11 
nâng cao, 2007), có thể hình thành grap 
ôn tập về hiđrocacbon no với hệ thống 
câu hỏi kèm theo để phát triển và hoàn 
chỉnh grap. Grap này được xây dựng cân 
đối song song giữa hai phần ankan và 
xicloankan. Chỉ cần nhìn vào grap một 
cách tổng thể, học sinh so sánh được sự 
tương đồng và khác biệt giữa chúng, 
đồng thời nắm ngay được nội dung bài ôn 
tập và các mối quan hệ giữa các phần 
kiến thức một cách dễ dàng. Dưới đây là 
grap nội dung bài 37:  



Tạp chí KHOA HỌC ĐHSP TP HCM   Số 28 năm 2011 
_____________________________________________________________________________________________________________ 
 
 

 86

 
 

 
 
 
 
 
 
 
 
    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
  

Hiđrocacbon no 

Ankan Xicloankan 

CnH2n+2 
(n≥1; nN) 

CnH2n 
(n≥3; nN) 

- Viết các đồng phân của ankan và xicloankan, gọi tên. 
- Phân biệt ankan và xicloankan. 
- Lập công thức phân tử của hiđrocacbon no dựa vào 
công thức chung và khối lượng mol phân tử trung bình. 
- Xác định công thức cấu tạo đúng của ankan và 
xicloankan dựa vào tính chất hóa học của chúng. 
- Tìm công thức phân tử của hiđrocacbon no dựa vào tỉ 
lệ mol CO2 và H2O thu được khi đốt cháy. 

1.Trong công nghiệp  
   Chủ yếu tách từ dầu mỏ 
2.Trong phòng thí nghiệm 

( )
3 ( ) 4 2 3o

CaO
r t

CH COONa NaOH CH Na CO  
   Al4C3 + 12H2O → 3CH4↑ + 4Al(OH)4 

Chủ yếu tách từ dầu mỏ hoặc điều chế từ 
ankan.  

CH3[CH2]4CH3
to,xt + H2

 

- Là nhiên liệu quan trọng nhất. 
- Làm nguyên liệu cho công nghiệp hóa chất. 

- Làm nhiên liệu, nguyên liệu.  

1. Phản ứng thế với halogen (cơ chế gốc) 

2 2 2 2 2
as

n n n n xC H xX C H X xHX    
2. Phản ứng tách 

CnH2n+2 Cn'H2n'+2+CmH2m

CnH2n+H2xt

to  
  (n’+m=n; n≥3; n’≥1;m≥2) 
3. Phản ứng oxi hóa 
    a. Cháy 

2 2 2 2 2
3 1 ( 1)

2n n
nC H O nCO n H O


   

  (
2 2CO H On n ) 

    b. Oxi hóa không hoàn toàn 
      ,

4 2 2

ot xtCH O HCH O H O     
- Không làm mất màu dung dịch KMnO4 

liên kết σ; mạch hở liên kết σ; mạch vòng 
 

- C1-C4 ở thể khí, không màu. Nhiệt độ nóng 
chảy, nhiệt độ sôi, khối lượng riêng tăng theo 
phân tử khối. 
- Nhẹ hơn nước, không tan trong nước, tan trong 
các dung môi hữu cơ. 

- C3 ,C4 ở thể khí, không màu. Nhiệt độ sôi, 
nhiệt độ nóng chảy, khối lượng riêng tăng 
theo phân tử khối. 
- Nhẹ hơn nước, không tan trong nước, tan 
trong các dung môi hữu cơ. 

Xicloankan có số C lớn hơn 4 tham gia phản 
ứng thế, tách, oxi hóa tương tự ankan. 
1. Phản ứng thế với halogen (cơ chế gốc) 

2 2 2
as

n n n n xC H xX C H X xHX    
2. Xiclopropan có phản ứng cộng mở vòng 
với H2, Br2, HBr . . .xiclobutan có  phản 
ứng cộng H2 

+ Br2 Br-CH2-CH2-CH2-Br
3. Phản ứng oxi hóa 
    a. Cháy 

     2 2 2 2
3
2n n
nC H O nCO nH O    

  (
2 2CO H On n ) 

    b. Oxi hóa không hoàn toàn 
- Không làm mất màu dung dịch KMnO4 
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2.6. Biện pháp 6: Sử dụng phương 
pháp algorit dạy học thích ứng với nội 
dung và đối tượng học sinh 

Nếu grap cho phép mô tả cấu trúc 
hoạt động thì algorit cung cấp phương 
tiện điều khiển hoạt động đó và tự điều 
kiển bản thân trong quá trình hoạt động.
 Phương pháp algorit dạy học thích 
ứng với nhiều đối tượng học sinh: giỏi, 
khá, trung bình và yếu. Hầu hết học sinh 
đều thấy việc giải quyết các vấn đề học 
tập trở nên đơn giản hơn nếu được giáo 
viên hướng dẫn cách thực hiện một yêu 
cầu, nhiệm vụ theo từng bước cụ thể, rõ 
ràng. Với học sinh khá, giỏi những bài 
tập dạng mới chỉ cần giáo viên hướng 
dẫn các bước giải vài lần là các em nắm 
được và làm tốt các bài tương tự. Nhưng 
đối tượng này lại rất dễ nhàm chán với 
những gì lặp đi lặp lại nhiều lần. Vì thế, 
tùy thuộc vào đối tượng học sinh, ta 
quyết định chọn lựa và áp dụng phương 
pháp này trong thời lượng bao lâu, nội 
dung nào phù hợp. 

Ưu điểm chính của phương pháp 
algorit là áp dụng có hiệu quả trong một 
số bài luyện tập mang tính đại cương hay 
hướng dẫn học sinh giải bài toán hóa học 
dạng mới: bài toán lập công thức phân tử; 
viết công thức cấu tạo các đồng phân của 
hợp chất hữu cơ. Đặc biệt, bằng phương 
pháp algorit, giáo viên giúp học sinh 
trung bình, yếu rèn luyện được thói quen 
phân tích đề bài, xử lí dữ kiện để tìm ra 
kết quả bài toán theo đúng yêu cầu. 

Ví dụ: Ở bài 29 - luyện tập Chất 
hữu cơ, công thức phân tử (SGK Hóa học 
11 nâng cao, 2007), giáo viên có thể tổ 
chức các hoạt động của học sinh bằng các 

phiếu học tập; yêu cầu học sinh lập công 
thức phân tử theo các phương pháp khác 
nhau. Sau đó, giáo viên tổng hợp thành 
bảng so sánh các bước giải của mỗi 
phương pháp. Bảng này giúp học sinh 
nhớ được các bước giải bài toán lập công 
thức phân tử và tìm ra ưu điểm của mỗi 
phương pháp để vận dụng vào việc giải 
các bài toán tương tự.  

Với bài 32 - luyện tập Cấu trúc 
phân tử hợp chất hữu cơ, mục tiêu của 
bài là rèn luyện cho học sinh kĩ năng viết 
công thức cấu tạo hợp chất hữu cơ. Để 
học sinh viết được đầy đủ các đồng phân 
mà không trùng lặp, giáo viên sử dụng 
phương pháp algorit dạy học, rút ra cách 
viết đồng phân cho hợp chất hữu cơ 
CxHyOzNt theo từng bước. Cụ thể như: 

Bước 1: Tính (Л + v): 

 2 2( )
2

x y tv   
   

+ Nếu (Л+v) = 1 nghĩa là: Л = 1 thì 
v = 0 hay Л = 0 thì v = 1 => hợp chất hữu 
cơ có 1 liên kết đôi C=C (hay C=O) hoặc 
1 vòng no. 

+ Nếu (Л+v) = 2 nghĩa là:   
o Nếu Л = 2; v = 0 => hợp chất 

hữu cơ có 1 liên kết 3 C≡C (hay C≡N); 
hoặc 2 liên kết đôi C=C (hay C=O); hoặc 
1 liên kết đôi C=C và 1 liên kết đôi C=O.  

o Nếu Л = 1; v = 1 => hợp chất 
hữu cơ có 1 liên kết đôi C=C (hay C=O) 
và 1 vòng no. 

o Nếu Л = 0; v = 2 => hợp chất 
hữu cơ có 2 vòng no.  

Bước 2: Xác định loại nhóm chức. 
Bước 3: Viết tất cả các mạch 

cacbon có thể có. 
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Bước 4: Đặt liên kết Л hay nhóm 
chức vào các vị trí khác nhau trên mạch 
cacbon. 

Bước 5: Bão hòa hóa trị cacbon 
bằng các nguyên tử hiđro.  

Giáo viên cũng cần phải lưu ý học 
sinh: công thức tính (Л + v) trên chỉ đúng 
khi hợp chất hữu cơ chỉ có liên kết cộng 
hóa trị trong phân tử.  
2.7. Biện pháp 7: Tổ chức thảo luận 
nhóm để tăng cường khả năng hoạt 
động tích cực của học sinh 

Định hướng đổi mới phương pháp 
dạy học theo hướng tích cực hiện nay đòi 
hỏi hoạt động dạy và học cần có sự kết 
hợp giữa hoạt động cá nhân với hoạt 
động hợp tác; giữa giáo viên với học 
sinh; giữa học sinh với học sinh. Nó thể 
hiện mối quan hệ tương tác trong môi 
trường thân thiện, an toàn.  

Trong giờ ôn, luyện tập dù ta sử 
dụng bất kì phương pháp dạy học nào thì 
việc tổ chức thảo luận nhóm cũng là cần 
thiết. Điều này giúp tăng cường khả năng 
hoạt động tích cực của học sinh, nâng 
cao hiệu quả của giờ học. Giáo viên có 
thể tổ chức cho học sinh hoạt động nhóm 
bằng nhiều hình thức khác nhau: vận 
dụng cấu trúc Jigsaw, thảo luận nhóm 
theo kiểu cặp đôi, thảo luận theo nhóm 
học tập thông thường.  

Chúng ta không xa lạ mấy với thảo 
luận nhóm theo kiểu cặp đôi và nhóm học 
tập thông thường. Nhưng với cấu trúc 
Jigsaw có lẽ chúng ta cũng cần nắm bắt 
một vài nét cơ bản để có thể vận dụng tốt 
hơn. Đây là phương thức tổ chức hoạt 
động học tập theo nhóm khá ưu việt và 
thích hợp với tiết ôn, luyện tập có nhiều 

nội dung. Muốn tổ chức hoạt động nhóm 
theo cấu trúc Jigsaw, giáo viên phải 
hướng dẫn từng bước các hoạt động cho 
học sinh nắm vững và thực hiện: 

- Phân chia nhóm học tập gọi là 
nhóm hợp tác gồm từ 5 đến 8 học sinh. 

- Phân công trách nhiệm cho các 
thành viên trong nhóm: 1 nhóm trưởng, 1 
thư kí nhóm; mỗi thành viên còn lại chịu 
trách nhiệm nghiên cứu một vấn đề gọi là 
các chuyên gia. Số lượng nhóm chuyên 
gia thông thường bằng số vấn đề cần thảo 
luận. Số nhóm hợp tác có thể nhiều hơn 
hoặc ít hơn số nhóm chuyên gia. 

- Quy định thời gian cho nhóm 
chuyên gia thảo luận nắm kĩ vấn đề 
nghiên cứu và giảng giải lại cho các 
thành viên của nhóm hợp tác cùng nắm 
bắt tất cả các vấn đề. Trong quá trình 
thảo luận của nhóm chuyên gia hay nhóm 
hợp tác, giáo viên luôn theo dõi, hướng 
dẫn để học sinh hiểu kĩ nội dung bài học. 

- Sau đó, giáo viên cho học sinh làm 
bài kiểm tra xoáy vào những nội dung 
vừa thảo luận để nắm được mức độ tiếp 
thu kiến thức của học sinh.  

- Dựa vào kết quả bài kiểm tra, giáo 
viên và học sinh cùng nhận xét, đánh giá 
thi đua giữa các nhóm và các thành viên 
trong nhóm. 

Mặt khác, trước khi tổ chức các 
hoạt động học tập theo nhóm, giáo viên 
nên dành thời gian hướng dẫn, thống nhất 
cách làm việc với học sinh: 

- Hướng dẫn chung cho học sinh 
phương thức thảo luận nhóm. Hướng dẫn 
cho trưởng nhóm cách điều hành buổi 
thảo luận; thư kí nhóm cách ghi biên bản. 
Việc này giúp học sinh tránh được tâm lí 
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lúng túng khi nhận nhiệm vụ, sớm ổn 
định tổ chức. Nhờ đó, tạo được bầu 
không khí học tập sôi nổi, tích cực.  

- Tổ chức thi đua giữa các nhóm để 
kích thích mọi thành viên tham gia vào 
hoạt động học tập. Kết quả học tập là kết 
quả chung của nhóm. Giáo viên nên ghi 
điểm tổng cho cả nhóm để học sinh tự 
chia ra tùy theo sự đóng góp của từng 
thành viên trong nhóm. Điều này nhằm 
phát huy tính tự giác và hạn chế được 
tình trạng ăn theo của một số cá nhân thụ 
động trong giờ thảo luận. 

- Mặt khác, mỗi nhóm thường có một 
số học sinh nổi trội. Giáo viên cần quan 
tâm khích lệ những học sinh này; bồi 
dưỡng cho các em cả về kiến thức lẫn 
phương pháp học tập để học sinh tự rèn 
luyện, phát huy năng lực của mình. 

- Trong khi thảo luận, học sinh có thể 
mãi mê suy nghĩ, nêu ý kiến, theo dõi ý 
kiến của bạn, không kịp ghi bài. Giáo 
viên cần giúp học sinh biết cách sắp xếp 
các vấn đề thảo luận, ghi bài có hệ thống. 

- Việc đánh giá thành công và hạn 
chế của nhóm được đưa ra bàn bạc một 
cách công khai nhằm rèn luyện cho học 
sinh khả năng nhận xét, đánh giá một 
cách khách quan. Qua đó, giúp học sinh 
rút ra được kinh nghiệm học tập cho bản 
thân và cho nhóm. 

- Phần tổng kết thảo luận nhóm, giáo 
viên phải dựa trên kết quả thảo luận, 
nhận xét của học sinh để giúp học sinh 
nhìn nhận vấn đề một cách chính xác. 
Giáo viên để ý bổ sung những thiếu sót, 
giải tỏa những vướng mắc về kiến thức 
cũng như mối quan hệ giữa các thành 
viên.  

2.8. Biện pháp 8: Phân bố thời gian 
hợp lí trong giờ ôn, luyện tập  

Dựa vào mục tiêu bài dạy, nội dung 
kiến thức và kĩ năng cần rèn luyện, giáo 
viên quyết định phân chia thời gian cho 
mỗi phần: kiến thức cần nắm vững và 
luyện tập sao cho phù hợp.   

- Đối với bài ôn tập, lượng kiến thức 
khá nhiều, mang tính tổng hợp của cả học 
kì hay một phần của chương trình. Vì thế, 
thời gian dành cho phần hệ thống hóa 
kiến thức có thể là 30 phút và phần luyện 
tập lại các dạng bài tập có thể là 10 phút 
cuối.  

- Đối với bài luyện tập, tùy vào dung 
lượng kiến thức và kĩ năng cần ôn, luyện, 
thời gian giữa phần kiến thức cần nắm 
vững và phần luyện tập có thể theo tỉ lệ 1: 
2 hay 1:3.  

Ngoài ra, khi tổ chức các hoạt động 
dạy học, giáo viên còn phải phân thời 
lượng cho từng hoạt động cụ thể. Ví dụ 
về bài luyện tập: 

- Thời gian ổn định lớp và kiểm tra 
việc chuẩn bị bài của học sinh cần nhanh 
gọn, khoảng từ 2 đến 3 phút; 

- Thời gian phân chia nhóm và phát 
phiếu học tập phải nhanh, khoảng 1 phút; 

- Thời gian dành cho phần kiến thức 
cần nắm vững khoảng 10 phút; 

- Thời gian dành cho luyện tập 
khoảng 30 phút.  

Cho nên, sự chọn lựa nội dung, yêu 
cầu trên phiếu học tập để đảm bảo mục 
tiêu mà không bị cháy giáo án là vấn đề 
cần cân nhắc. 

+ Vào đầu giờ, giáo viên có thể đưa 
ra bảng quy ước thời gian để học sinh 
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thực hiện các nhiệm vụ học tập theo đúng 
trình tự và tiến độ. 

+ Giáo viên có thể phân chia mỗi 
nhóm một nhiệm vụ trong phiếu học tập 
để yêu cầu học sinh thực hiện.  

+ Nếu sử dụng biện pháp luyện tập 
theo từng chủ đề thì thời gian dành cho 
mỗi chủ đề có thể từ 7 đến 10 phút. 

+ Nếu tổ chức thảo luận nhóm thì 
thời gian thảo luận và đánh giá kết quả 
phải được quy định rõ ràng. 

+ Trường hợp học sinh lúng túng 
khi giải quyết vấn đề, giáo viên phải kịp 
thời gợi mở để học sinh tìm ra phương án 
nhanh chóng. 

+ Cuối giờ học, giáo viên phải có 
phần nhận xét chung về những mặt tích 
cực, những hạn chế cần khắc phục, 
hướng dẫn những việc cần chuẩn bị cho 
tiết học sau (khoảng từ 2 đến 3 phút). Để 
học sinh phát huy tốt khả năng tự học, 
giáo viên cần hướng dẫn cụ thể nội dung 
vấn đề mà giáo viên yêu cầu học sinh tự 
nghiên cứu. 
2.9. Biện pháp 9: Phối hợp hài hòa các 
phương pháp dạy học trong giờ ôn, 
luyện tập  

Về mặt lí luận, không có phương 
pháp dạy học nào là hoàn toàn tối ưu và 
cũng không có phương pháp nào là hoàn 
toàn tiêu cực. Điều quan trọng là ta phải 
biết phối hợp hài hòa các phương pháp 
dạy học để đạt hiệu quả; phải tạo điều 
kiện cho học sinh chủ động, sáng tạo 
trong việc tìm kiếm tri thức, gắn kiến 
thức với thực tiễn.  

Ví dụ: Ở bài 29 - luyện tập Chất 
hữu cơ, công thức phân tử (sách giáo 
khoa hóa học 11 nâng cao, 2007), các vấn 

đề về phương pháp tách biệt và tinh chế; 
phân tích định tính và định lượng các 
chất hữu cơ dường như còn rất mới mẽ 
với học sinh. Mặc dù ở phần lí thuyết, 
các em đã nắm qua các phương pháp này. 
Nhưng để sát hơn với thực nghiệm và 
đáp ứng các câu hỏi mang tính thực 
nghiệm, giáo viên cần hướng dẫn thật cụ 
thể. Vì vậy, ta có thể phối hợp phương 
pháp algorit dạy học với phương pháp 
đàm thoại gợi mở và tổ chức hoạt động 
học tập theo nhóm để phát huy khả năng 
hợp tác giải quyết vấn đề của học sinh. 

Với bài 37- luyện tập Ankan và 
xicloankan (sách giáo khoa Hóa học 11 
nâng cao, 2007), ta có thể phối hợp 
phương pháp grap dạy học với đàm thoại 
nêu vấn đề và sử dụng bài tập hóa học 
theo chủ đề. Để so sánh sự tương tự và 
khác biệt về tính chất vật lí, tính chất hóa 
học của ankan và xicloankan; nguyên 
nhân dẫn đến sự khác biệt đó, ta sử dụng 
phương pháp grap dạy học là thích hợp. 
Khi xây dựng grap nội dung nhất thiết 
phải dùng phương pháp đàm thoại nêu 
vấn đề nhằm kích thích học sinh suy 
nghĩ, phát triển khả năng tư duy sáng tạo. 
Đồng thời, sử dụng bài tập hóa học theo 
chủ đề giúp học sinh dễ nhớ được các 
dạng bài tập và cách giải các bài tập 
trong chương Hiđrocacbon no. Trên cơ 
sở đó, học sinh có thể tự tìm ra cách giải 
những bài tập tương tự.  
3. Kết luận 

Quan điểm dạy học hướng tới 
người học và theo hướng hoạt động hóa 
người học yêu cầu người thầy phải biết 
chọn lọc nội dung vừa sức, chọn lựa 
phương pháp thích hợp và sử dụng biện 
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pháp hữu hiệu nhằm đáp ứng từng đối 
tượng học sinh để giờ dạy có chất lượng, 
học sinh được học tập trong hoạt động tự 
giác tích cực, phát triển năng lực sáng 
tạo. Sự đầu tư cho một giờ ôn, luyện tập 
như thế mất rất nhiều thời gian và công 
sức, đòi hỏi người thầy thực sự có tâm 
huyết với nghề.  

Có một điều thường dễ bị quên về 
mặt chủ thể dạy học - người thầy cũng có 
những mặt ưu và khuyết nhất định. Chính 
vì vậy, việc chọn lựa phương pháp, sử 
dụng biện pháp cho một giờ dạy cần có 
sự tương hợp giữa chủ thể dạy - thầy và 
đối tượng học - trò. Trong vai trò chủ 

đạo, người thầy có nhiều ưu thế trong 
việc quyết định chọn lựa phương pháp, 
biện pháp và giới hạn nội dung sao cho 
phù hợp.  

Một số biện pháp nhằm nâng cao 
chất lượng giờ ôn tập, luyện tập phần 
hóa học hữu cơ lớp 11 như đã được trình 
bày trên đây không chỉ dùng cho giờ ôn 
tập, luyện tập phần hóa học hữu cơ lớp 
11 mà còn có thể áp dụng cho hầu hết các 
giờ ôn tập, luyện tập của bộ môn hóa học. 
Một số biện pháp có thể dùng cho nhiều 
môn học khác, chúng ta có thể chọn lựa, 
kết hợp hay tích hợp cho một giờ dạy tùy 
thuộc vào điều kiện của từng người. 
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